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Chapter 1 Introduction 

 
This chapter provides an overview of NEC-WIN SYNTH and its features.  It also lists 
features for all programs in the NEC-WIN Family.  The last section is an overview of how 
to navigate in the Microsoft Windows operating environment. 

What is NEC-WIN SYNTH?  
NEC-WIN SYNTH is an intuitive program that helps antenna designers quickly and 
effectively design and analyze antennas.  Novice and advanced designers alike will 
appreciate the power and ease-of-use of this program.  Problems that previously took hours 
to describe using alternate antenna modeling software can now be entered in a fraction of 
that time.  If you have been hesitant to use computational tools because of their complexity, 
then easy-to-use NEC-WIN SYNTH is for you.  

Some of the key features of NEC-WIN SYNTH include: 

• Simple user interface.  The inherent complexity of NEC has been eliminated through 
use of graphical screens that prompt you to enter the required information.  

• Easy data entry.  NEC-WIN SYNTH makes describing antenna geometry as easy as 
entering numbers in a spreadsheet.  After you enter the start and stop point for each 
wire, you can easily modify each wire using the cut, copy, and paste features.  In 
addition, entire wires and groups of wires can be rotated, scaled, and moved by 
accessing the appropriate button command.  There is no need to perform tedious math.  
NEC-WIN SYNTH does all of the math for you.  

• Graphical representation of your antenna.  In order to ensure that your geometry is 
correct, you can view the antenna structure in the Display Window.  This display 
provides a three dimensional representation of the antenna which can be rotated, 
panned, zoomed, and printed.  You can view individual segments and the 
corresponding cards in the input files, making it easy to edit your antenna information. 
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The NEC-WIN Family 
NEC-WIN SYNTH is the newest of the products that Nittany Scientific, Inc. has released to 
support antenna designers.  The other products are NEC-WIN PLUS+, NEC-WIN Pro, and 
GNEC-4.  These products differ widely in the level of features provided, price, and usage.   

NEC-WIN SYNTH is designed to allow users to quickly build complex antenna structures. 
NEC-WIN PLUS+  provides a wide range of features that are part of the NEC2 core while 
retaining a very simple user interface.  NEC-WIN Pro is designed for engineers that require 
more capability than is available through NEC-WIN PLUS+.  GNEC-4 adds more power by 
using the NEC4 core.   

Hardware and Software Requirements 
To install and run NEC-WIN SYNTH, you will need the following: 

• Microsoft Windows 95/98/Me/2000 or Windows NT 4.0 

• Graphics 800x600 with 256 colors or greater 

• CD-ROM for installation 
 

NEC-WIN SYNTH Technical Support 
Nittany Scientific, Inc. offers on-line technical support to registered users through our web 
site located at http://www.nittany-scientific.com, via email at tech-support@nittany-
scientific.com, or by fax at (801) 446-1426.  Before receiving technical support, you will be 
required to provide your NEC-WIN SYNTH product registration number. 

Before You Contact Us 

Save yourself time and money by first consulting this manual and the on-line help in an 
attempt to answer the question yourself.   

• Look in the Reference and User’s Manual.  Use all available documentation to try to 
find the information you need. 

• Try to pinpoint the problem.  Check coordinates, analysis parameters, and analysis 
options for your antenna, and then run NEC-WIN SYNTH again.  If appropriate, try 
building and testing a similar antenna.  Look at the examples included in the User’s 
Manual. 

Contacting Us 

Fax: Fax us a printout of your antenna input file with a listing of the expected outputs for 
your antenna so we can analyze the problem before contacting you.  Please include your 
name, address, phone number, and fax number.  Our fax number is (801) 446-1426. 

  Nittany Scientific, Inc. 
  1733 W 12600 S, Suite 420 
  Riverton, UT 84065-7043 
  Phone/Fax: (801) 446-1426 
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About this Manual 

Assumptions 

This manual assumes that you are familiar with antenna design concepts.  If you do not 
know these concepts, you should familiarize yourself with them before using NEC-WIN 
SYNTH. 

This manual also assumes that you are familiar with the basics of using your PC.  If you are 
not familiar with using the Windows 95/98/Me/2000 or NT operating system, you can refer 
to the NEC-WIN SYNTH Navigation section later in this chapter. 

How to Use This Manual 

This manual is not meant to be read cover to cover.  Refer to the appropriate sections for 
needed information: 

Chapter 1 Introduction This chapter gives an overview of NEC-WIN SYNTH and its 
features.  It also lists features for all programs in the NEC-
WIN family.  The last section is an overview of how to 
navigate in the Microsoft Windows operating environment. 

Chapter 2 Installation Read this chapter to learn how to install and quickly begin to 
use NEC-WIN SYNTH. 

Chapter 3 Reference  This chapter describes the NEC-WIN SYNTH features in  
 detail.  Refer to this section when you have specific  
 questions about features. 
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NEC-WIN SYNTH Navigation 
Before you begin to use NEC-WIN SYNTH, let’s take a brief look at basic navigation.  If you 
are familiar with Microsoft Windows, you should know this information.  Skip this section 
and go on to Chapter 2. 

Using a Mouse 

You must have a mouse to operate NEC-WIN SYNTH.  If you are unfamiliar with the mouse, 
here are some mouse basics: 

• Moving the mouse moves the pointer.  To make a selection, position the pointer on the 
selection and press the LEFT mouse button.  This is known as “clicking on” the 
selection.   

• Sometimes you may need to click twice in quick succession on a selection.  This is 
known as “double clicking.”  

• To “highlight” or “select” text, place the pointer at the beginning of the text, hold down 
the left mouse button and move across the text until the entire area you want to select is 
highlighted.  When you have completed your selection, release the mouse button. 

• To “click and drag” an object, place the pointer on the object, then press and hold 
down the mouse button while you move the mouse.  The object will also move.  When 
the object is where you want it to be, release the mouse button. 

Pull-down Menus 

NEC-WIN SYNTH uses pull-down menus.  To access the choices under a menu item, use the 
mouse to point and click on a selection on the menu bar.  The pull-down menu appears.  To 
select a menu item, point and click on that item.  To remove the menu without making a 
selection, move the pointer outside the menu and click. 

Buttons 

Buttons in addition to the menu bar appear across the top part of the window.  To select a 
button, simply point and click on the button with your mouse. 

Multiple Windows 

You will use windows to enter geometry information and manipulate pattern plots.  You 
can have multiple windows open at one time, and movement between windows is fast and 
easy.  Simply use the minimize and maximize buttons in the upper right-hand corner of 
each window. 

Minimize Minimizing a window reduces the window to an icon at the bottom of the 
screen.  To minimize a window, click on the minimize button.  To restore a 
window from an icon back to its original size, double click on the icon.  You 
can also choose these options from the Control-Menu Box (see the following 
section). 

Maximize To enlarge the window so that it takes an entire screen, click on the maximize 
button. 

Restore To restore a window from an icon back to its original size, click on the 
Restore button at the top right of the window.  

Close Close the window. 
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Using the Control-Menu Box 

The Control-Menu Box is the small rectangular icon in the upper left corner of a window or 
the program icon.  Click on the button and several window arranging menu choices appear. 
Typical menu options include: 

Restore Restore the window to its previous state. 

Move  Move the window by using arrow keys on the keyboard. 

Size Resize the window by using arrow keys on the keyboard.  

Minimize Minimize the window to an icon at the bottom of the screen.   

Maximize Maximize the window to the greatest size possible.  

Close  Close the window. 
 

NOTE:  Your choices may vary, depending on the window. 

 



 

 
NEC-WIN SYNTH Reference Manual 6 2001 Nittany Scientific, Inc 
 

Chapter 2 Installation 

 
NEC-WIN SYNTH is designed to be both powerful and easy to use.  If you have used 
Microsoft Windows, you know how to navigate through the program.  If you have a basic 
understanding of antenna design, you should be able to use this program with very little 
orientation. 

NOTE:  A quick review of navigation in Microsoft Windows is provided in Chapter 1, 
Introduction.   

This chapter is designed to give you the basic information you need to get up and running 
on NEC-WIN SYNTH.   

The sections in this chapter are: 

Installation How to Install NEC-WIN SYNTH on your system. 
 
Starting NEC-WIN SYNTH How to launch the NEC-WIN SYNTH program. 
 
What’s on the NEC-WIN  Overview of what you see on the NEC-WIN  
SYNTH Screen? SYNTH Screen. 
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Installation  
Follow these steps to install NEC-WIN SYNTH in Windows 95/98/Me/2000 or NT: 

1. Place the NEC-WIN SYNTH CD in your CD-ROM drive.   

2. From the Start button in Windows, select Run. 

3. At the Start, Run command line, type D:\NWSYNTH\SETUP.  Then click on OK.  
(Substitute your CD-ROM drive letter if D: does not match your configuration.) 

The NEC-WIN SYNTH installation begins.  You will then be prompted for the drive and 
the directory where you want to install NEC-WIN SYNTH (the default is C:\Program 
Files\NEC-SYNTH).   

 

NOTE: NEC-WIN PLUS+ Users 
To use NEC-WIN SYNTH with NEC-WIN PLUS+, you should install the program into the 
NEC-WIN PLUS+ directory. i.e. C:\NEC-PLUS.  Remove NEC-WIN SYNTH from the install 
path. i.e. C:\PROGRAM FILES\NEC-PLUS.  Do not install into C:\PROGRAM FILES\ 
NEC- PLUS\NEC-SYNTH. 
 

4. Follow the on-screen directions to complete the installation of NEC-WIN SYNTH.   

5. At the conclusion of the installation, you will be asked whether you want to create 
Program Manager Groups.  Click on Yes and the NEC-WIN SYNTH program group will 
be installed along with the NEC-WIN SYNTH Icon and the Readme file within the 
program group.   
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Chapter 3 Reference 
 

Starting NEC-WIN SYNTH 
 
Once you have installed NEC-WIN SYNTH, follow these simple steps to start the program: 
 
NOTE: NEC-WIN SYNTH can be launched as a stand-alone program, or as an integrated tool from within 
NEC-WIN PLUS+.  Once the program has been started, however, it works the same regardless of how it was 
launched. 

 

Running from NEC-WIN PLUS+ 

1. It is very easy to call the NEC-WIN SYNTH program from within NEC-WIN PLUS+. 
Within NEC-WIN PLUS+, decide which row should be the start of your synthesized 
geometry and click the right mouse button on that row. In the sub-menu that appears 
choose "Insert Synthesizer Output". NEC-WIN SYNTH will open and you can generate 
a model.  When finished in NEC-WIN SYNTH, choose Update and Exit. The geometry 
will then be inserted into the NEC-WIN PLUS+ spreadsheet.  In Windows, click on the 
NEC-WIN PLUS+ Program Group, from the Start button. 

2. Even if you have NEC-WIN PLUS+ installed, you can 
still start NEC-WIN SYNTH stand-alone by selecting 
Programs, NEC-WIN PLUS+, NEC-WIN SYNTH from 
the Start button. 

 

 
 
 
 
 
 
Running as a stand-alone program 

1. In Windows, click on the NEC-WIN SYNTH Program Group, from the Start button. 
 
The NEC-WIN SYNTH Program 
Group contains the NEC-WIN 
SYNTH icon. 
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2. Select the NEC-WIN SYNTH icon to start the program.  NEC-WIN SYNTH consists of 
two main interfaces; the Display Window, which is active, and the Spreadsheet. 

 



  Chapter 3 Reference 

 
NEC-WIN SYNTH Reference Manual 11 2001 Nittany Scientific, Inc 

What’s On the NEC-WIN SYNTH Screen? 
Once you are in NEC-WIN SYNTH, take a few moments to get acquainted with the screen.  
There are two main interfaces which comprise NEC-WIN SYNTH, the Display Window and 
the Spreadsheet.  Each consists of three main areas.  A description of each area follows. 

Display Section 
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Menu Options  
Across the top of the screen is the 
menu bar, which contains the File, Edit, View, Options, and Help menus.  These menus 
can be used to select the same functions as many of the function buttons. 

File Menu 

From the File menu, you can start a new input file with the 
New command or you can access an existing NEC-WIN 
SYNTH.(.NWS) file with the Open command.  The Save 
and Save As commands allow you to save an .NWS 
formatted file into either the .NEC, ASCII (.TXT) or 
EZNEC format.  Add Model File opens a .NEC, .TXT or 
AutoCAD (.DXF) file.  Save as Bitmap saves the display 
in bitmap format.  The Print Model command allows you 
to print the display.  Use the Exit command to exit NEC-
WIN SYNTH. 

 

Edit Menu  

This menu provides functions for editing the 
display of your NEC input file.  Get Pair of 
Coordinates allows you to connect a new wire 
between any two existing wires.  The ReCalc 
World Coordinates command examines the 
geometry and resizes the model in the display 
window to the best resolution to fit the entire model.  Use Copy Model to Clipboard to 
copy the display to the clipboard, and Delete Last Model to help you to edit your antenna 
display. 

View Menu 

The Zoom Area and Zoom Out commands allow you 
to zoom a selected portion of the display window or 
decrease zoom respectively.  Selecting Axis and Axis 
Labels toggles each feature on and off.  Axis Label 
Size allows changing the size of the axis labels.  Show 
Coord Box Size controls the size of the boxes that 
appear when using Get Coordinate or Get Pair of 
Coordinates.  Click on Center Model to place the 
antenna in the middle of the display window.  In 
addition, you can view characteristics of your 
geometry with the World Information option. 
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Options Menu 

The Colors menu selection allows you to 
customize the display colors of your 
geometry.  Select Prompt for New File 
when Adding Models and every time a 
new model is added you will be prompted whether or not you wish to start a new file.  All 
of the predefined models have default values. As you use the program it will store your 
values as the default for each model. When you select Reset All Models to Default Values 
ALL of the models will be restored to their default values. 

Help Menu 

Access on-line Help using this option.  About displays 
information about the product version. 

 

NOTE: Several of these functions are also available from the buttons on the Function Bar.  
See the Function Button section for more information on these functions. 

 

Function Bar 
This function bar or button bar contains a variety of icon buttons that are shortcuts for many 
of the functions that are contained in the menus.  If you point to the button with your mouse 
for over one second, a short explanation of the function appears. 

Close Display Window 

Use this button to close the Display Window.    

New Model  

Use this button to start a new input file.  You can only have one file open at a time. 

Open File  

Click here to access an existing NEC-WIN SYNTH (.NWS) file.    

Save Model  

The Save Model button allows you to save an .NWS formatted file into either the .NEC, 
ASCII (.TXT) or EZNEC format.  

Select Colors 

Use this button to customize the display colors of your geometry.  

Keep Window on Top 

This button is available in both the Display and Spreadsheet windows.  When enabled the 
chosen window will remain on top of the other window.  Use this feature when the 
windows overlap each other and you wish to see certain parts of both windows at the same 
time. 
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Check Model 

Validates the model. 

Reset the Display 

Resets the rotate, pan, zoom and options in the display window. 

Delete Last Model 

Deletes the last model from the display window. 

Zoom Area 

Highlight an area of your geometry and it will be magnified while maintaining focus on the 
selected area. 

Zoom Out 

Zooms Out. 

Print 

Prints the display. 
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Command Area 
Frequency 

This is where you change the frequency. 

Wavelength 

Indicates the wavelength of the chosen frequency. 

 

Units 

NEC-WIN SYNTH allows you the ability to choose meters, millimeters, 
centimeters, yards, feet, inches and wavelengths as units of measure. 

 

 

 

Type 

The Type controls what category of model you wish to generate. 
When you modify this value the tabbed control will change 
accordingly.  

 

 

 

Add Model 

Each model contains edit fields for parameters that are necessary 
for that model. To determine how each parameter will affect the 
model you can view the changes in the status box for each model 
or easily generate the model and view it in the display window. 

 

Segments/Wavelength 

Some models contains this parameter. The most typical value to 
use in NEC is 10 segments per wavelength.  For critical regions 
15 or 20 should be used.  In less critical regions 5 is usually 
sufficient.  If other values are desired you can modify the segmentation in the spreadsheet 
or in NEC-WIN PLUS+ if available. 
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Add Model File 
This feature allows you to import NEC, ASCII or AutoCAD .DXF files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rotate 
Rotates the geometry in the display window. 
 

Pan 
Moves the geometry around inside the display window. 
 

Zoom 
Increase/decreases the size of the geometry. 

NOTE: These commands all work by holding down with the left 
mouse button while moving the mouse.  You can scroll through 
these commands by double-clicking the mouse. 

Reset 
Resets the rotate, pan and zoom options to default. 
 

Axis 
Toggles the X, Y, and Z-axes on and off. 
 

Center 
Centers the geometry. 
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Check Model 
Press this button to validate the model.   

Note: See Geometry Checker section in NEC-WIN SYNTH User’s 
Manual for detailed instructions on this feature. 

 

Delete Last 
Deletes the last model from the display window. 
 
 

Add Grid 
Allows you to add a wire grid to the model. 
 

 
NOTE: See Miscellaneous Functions section in NEC-WIN SYNTH User’s Manual for further instructions on 
the Add Grid feature. 

Add Wire 

Allows you to add a wire grid to the model. 

 
NOTE: See Example 2 in NEC-WIN SYNTH User’s Manual for further instructions on the Add Wire feature. 
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Spreadsheet 
The spreadsheet in NEC-WIN SYNTH is a true spreadsheet. You can enter equations or reference 
other cells from within. 
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Menu Options  
 

The following section lists the main 
menu commands available in the spreadsheet.  Across the top of the screen is the menu bar, 
which contains the File, Edit, View, Options, Geometry Checker, and Help menus.  Most of 
these commands are also accessible from the toolbar or short-cut keys.   

 

File Menu 

From the File menu, you can start a new input file with the 
New command or you can access an existing NEC-WIN 
SYNTH (.NWS) file with the Open command.  The Save and 
Save As commands allow you to save an .NWS formatted file 
into either the .NEC, ASCII (.TXT) or EZNEC format.  Page 
Setup provides options for headers, footers, margins and other 
layout settings.  The Print Setup and Print commands allow 
you to print customized reports of your antenna information.  
Use Print Preview to see how your report will look prior to 
actual printing.  Use the Exit command to exit NEC-WIN 
SYNTH. 

 

Edit Menu 

The menu provides functions for editing your NEC input file.  
You can select Copy, and Paste and Select All to help you to edit 
your NEC input file. 

 

View Menu 

The ReCalc World Coordinates command examines 
the geometry and resizes the model in the display window to the best resolution to fit the 
entire model.   

Options Menu 

Auto Size Display World on Edits controls 
whether edits to the model will cause the model to 
be resized to fit into the display area.  For instance, 
if the model is zoomed and a wire is added which 
is outside the displayable area, the model will be resized to display the full model. 

Change Units 
allows you to select 
the option to change 
or retain numerical values in your input file when changing the units. 
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Export NEC 
File allows you 
to choose the 
format of an 
exported NEC 
file. 

Wire Thickness allows you to 
select diameter or radius as a 
measurement. 

 

Geometry Checker Menu 

Segment Length allows you to choose the method of automatic 
geometry checking NEC-WIN SYNTH will perform.  The options are displayed. 

 

 

Note: See Geometry Checker section in NEC-WIN SYNTH User’s Manual for detailed 
instructions on this feature. 

Help 

Access on-line Help using this option.  About displays 
information about the product version. 
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Function Bar 
 
This function bar or button bar contains a variety of icon buttons that are shortcuts for many 
of the functions that are contained in the menus.  If you point to the button with your mouse 
for over one second, a short explanation of the function appears. 

 
 

New Model 

Use this button to start a new input file.   

Open File 

Use to access an existing NEC-WIN SYNTH (.NWS) file. 

Save File 

Allows you to save an .NWS formatted file into either the .NEC, ASCII (.TXT) or EZNEC 
format 

Show Formulas 

 Use this button to show only formulas.  Works as a toggle. 

Highlight Selected Wire 

The Highlight Feature is the reverse of the Select Feature. When the Highlight button is 
depressed clicking on any wire in the Spreadsheet will highlight the wire back in the 
Display window.  

 

Check Model 

Use this command to validate the model.   

Note: See the Geometry Checker section in NEC-WIN SYNTH User’s Manual for detailed 
instructions on this feature. 

Show Display Window 

Opens Display window if necessary and makes it the active window. 

Keep window on top 

This button is available in both the Display and Spreadsheet windows.  When enabled the 
chosen window will remain on top of the other window.  Use this feature when the 
windows overlap each other and you wish to see certain parts of both windows at the same 
time. 

Select wires for geometry operations 

This button will cause all wires in the spreadsheet to be selected. 
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Delete Last Model 

Deletes the last model from the spreadsheet. 

 
Command Area 

 

Frequency 

This is where you change the 
frequency 

Wavelength 

Indicates the wavelength of the chosen frequency. 

Units 

NEC-WIN SYNTH allows you the ability to choose meters, millimeters, 
centimeters, yards, feet, inches and wavelengths as units of measure. 

 

 

 

Geometry 
 

Rotate Wires 

The Rotate function enables you to rotate the selected entries button around the x, y, or z-
axis. 

Move Wires 

Moves selected entries along the x, y, or z-axis. 

Scale Wires 

Scales each wire by a specified scaling factor. 

NOTE: See General Program Notes and Modeling Guidelines section in NEC-WIN 
SYNTH User’s Manual for detailed information on the use of these commands. 
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Auto segment selected wires 
Allows you to enter how many segments are 
on each wire by typing the value directly into 
the combo box.  You should highlight the 
wires you wish to auto-segment before 
choosing this option. 

 
 
 
 
 
 
 
 
 

Spreadsheet In-Line Commands 
 

The following commands are available when right-
clicking inside the spreadsheet. 

Get Coordinate 

Allows you to get the coordinates of a wire or segment 
endpoint from an existing wire. The obtained coordinates 
can replace existing coordinates in the spreadsheet or 
start a new wire. 
 
Within the spreadsheet, place the cursor at the location 
where you would like to place the new coordinates.  This 
can be an existing wire or a new line. If the cursor is 
located in columns 1 – 4, the new coordinates will replace X1, Y1, and Z1. If the cursor is 
in any other column, X2, Y2, and Z2 will be replaced.  
 
After positioning the cursor, click on the Get Coordinate menu option which is accessible 
from the right click menu on the Spreadsheet.  Using the right mouse button, click on 
different wires within the Display window.  As you click, the wire will be highlighted and 
boxes will be displayed at the segment endpoints. After highlighting the correct wire, press 
the F1 (function 1) key.  Using the right mouse button, click on the appropriate box to have 
those coordinates placed in the spreadsheet. 

Get Pair of Coordinates 

Allows you to connect a new wire between any two existing wires.  
 
Click on the Get Pair of Coordinates menu option.  The Get Pair of Coordinates dialog will 
appear.  Using the right mouse button, click on wires in the Display window.  The selected 
wire will be highlighted with boxes at the segment endpoints.  Once the desired wire is 
highlighted, hit the F1 (function 1) key then click on the appropriate box with the right  
mouse button.  The coordinates for that box will be placed in Coordinate Set 1 of the Get 
Pair of Coordinates dialog box.  Switch to Coordinate Set 2 by clicking the appropriate 
button or pressing the F3 key.  Repeat the above procedure to obtain coordinates for Set 2. 
Once the coordinates are obtained, click on the Add Wire button in the dialog to have a 
wire placed between the two sets of coordinates. 
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It is possible to manually enter coordinate values for Coordinate Set 1 or 2. 

Select All 

Allows you to select all lines. 

Insert Row(s) 

Inserts a new row in the spreadsheet. 

Deleted Selected Row(s) 

Deletes the row or rows selected. 

Copy Selected 

Copies the area which is highlighted to the clipboard. 

Paste Selected 

Pastes data from clipboard. 

Go to Line 

Moves you to the first or last line in the spreadsheet. 

ReCalc World Coordinates 

This command examines the geometry and resizes the model in the display window to the 
best resolution to fit the entire model.   
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